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exPressit™ Label Design Studio

quickSTART GUIDE
Memorex exPressit Label Design Studio allows you to professionally design and creatively personalize labels for

discs, storage cases and the iPod™. With a number of easy-to-use design features, label designs can be

completed in a simple process of clicking the mouse.

Minimum System Requirements

• Windows® 98SE, Me, 2000, or XP

• 64MB of RAM

• 64MB of Free Disc Space

• 200 MB for Image Library (optional)

• Internet explorer 5.0 or higher

• Recommended: Windows Media Player 9 or higher

• VGA or higher resolution (800x600 minimum resolution recommended)

• Windows Compatible Inkjet or Laser Printer

1) Quit all open programs including anti-virus software, which may be running.

2) Insert the software installation disc into your CD/DVD drive and follow the onscreen instructions to install

the software.

NNNNOOOOTTTTEEEE:::: If the software does not auto-run, then:

a) Double-click on the “My Computer” icon on the Windows desktop.

b) Double-click on your computer's CD/DVD drive.

c) Double-click on “setup.exe” in the main directory.

d) Follow the onscreen instructions to install the software.

Installing the Software

Double click the desktop icon or launch from the start menu:

Start Menu> Programs> Memorex exPressit Label Design Studio> Memorex exPressit Label Design Studio

Launching the Software
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1) Be sure to calibrate your printer before printing your first label. Calibrating your printer will help

ensure that your designs print perfectly on the label sheet every time. See pg. 4 for steps on how to

calibrate your printer. Always remember to save your settings.

2) Use the programmable options under the TTTToooooooollllssss menu to customize the software to your needs.

You can:

• Customize the appearance of the Label desktop.

• Determine how you want the software to access the Internet to obtain album information

for your music CDs.

• Enter personal information to be automatically inserted into designs.

• Customize the software startup screen. Choose from:

– Last Used File or Template - shows the design you last had open

– New Project Wizard - starts a new design

– File Open Dialog - shows all your previously saved templates

– Nothing - start from a blank screen

3) The Memorex exPressit tutorials located under the HELP section of the software are very

beneficial in learning how to use the software.

4) Register the software online and receive information on:

• Software updates and upgrades.

• Pre-designed templates for use in the software.

• Special offers on Memorex Label Refills, Jewel Cases, and more…

Quick Tips

Creating a new label with the exPressit Label Design Studio is simple and easy with the New CD Label

Wizard. To create a new label, you must choose NEW on the command bar or from the file menu. The

NewCD Label Wizard is launched.

Choose from 15 different label templates

There are label templates for:

• CDs

• DVDs

• Mini CDs/DVDs

• Jewel Cases

• DVDStorage Cases

• Business Card Discs

• iPods

First, choose from the product types. Then, choose from the label products. Once label stock is chosen,

click the NNNNEEEEXXXXTTTT button and the SmartDesigns process will begin. You can skip the SmartDesigns process

by selecting FFFFIIIINNNNIIIISSSSHHHH to take you straight to the design screen.

Creating a NEW label
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The SmartDesigns Wizard allows you to choose from a number of “intelligent templates” built into the soft-

ware. These pre-designed templates allow you to modify many different aspects of the design with just a

simple mouse click. This process allows a quick professional label design every time.

NNNNOOOOTTTTEEEE:::: If you do not wish to use the SmartDesigns process, you can remove the check mark in the “Use

SmartDesgins” box on the SmartDesigns Screen.

SmartDesigns Template

SSSStttteeeepppp 1111:::: Decide which label to create

a) Select the label you wish to design. To select from the list on the left side of the screen, use the

drop down arrow.

b) Select a Genre for the label design. Types offered are Audio, Data, or General Purpose.

NNNNOOOOTTTTEEEE:::: Genre types will differ depending on the label type selected.

SSSStttteeeepppp 2222:::: Choose a background

c) Use the BBBBrrrroooowwwwsssseeee BBBBaaaacccckkkkggggrrrroooouuuunnnnddddssss button and choose from over 1500 pre-designed backgrounds

in the included image library or import your own images from a photo database.

AND/OR:

d) Use the LLLLaaaayyyyoooouuuutttt VVVVaaaarrrriiiiaaaattttiiiioooonnnn BBBBaaaarrrr on the bottom right and choose from a number of predetermined

layouts for a quick label design.

Click the NNNNEEEEXXXXTTTT button to reach the final screen of the New CD Label Wizard.

d)

b)

a)

c)

1) Select the printer you would like to calibrate.

2) Select which “Paper Bin” you will be printing your labels from.

3) Select the correct “Feed Type” of your printer - Left, Center, or Right.

4) Click on the “Print Calibration Sheet” button to print a print calibration sheet on a plain sheet of paper.

5) Follow instructions on that sheet and adjust the “Horizontal” and “Vertical” offset numbers.

NNNNOOOOTTTTEEEE:::: You may have to repeat the above steps as needed before accurately calibrating your printer.
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SSSStttteeeepppp 3333:::: Import a playlist to finalize the design

e) You have the option to import a playlist or go straight to the design screen.

NNNNOOOOTTTTEEEE:::: You will not see this screen if you choose “General Purpose” Genre for your label design.

Select FFFFiiiinnnniiiisssshhhh and your New CD Label Wizard is complete!

Once the NewCD Label Wizard is complete, your newly designed label is ready to print or you can continue to

edit your label design using the features of the exPressit Label Design Studio.

e)

Printer Calibration

Memorex has included a print calibration tool that will help you with print positioning. This will help ensure your

designs print perfectly on the label sheet.

NNNNOOOOTTTTEEEE:::: There must be at least 1 label design open to perform print calibration.

Under the FFFFIIIILLLLEEEE menu, click on CCCCaaaalllliiiibbbbrrrraaaatttteeee PPPPrrrriiiinnnntttteeeerrrr.

Below is the screen that will appear and follow these steps:

Step #1

Step #2

Step #3

Step #4

Step #5

Step #6
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BBBBaaaacccckkkkggggrrrroooouuuunnnnddddssss::::

- Choose from over 1500 exPressit Backgrounds.

- Import your own background off the Internet or from

a database.

- Backgrounds are automatically applied to fit your label.

PPPPiiiiccccttttuuuurrrreeeessss////CCCClllliiiippppaaaarrrrtttt::::

- Browse through a number of clipart images.

- Choose from a number of different symbols.

- Use the Picture Touchup & Effects to enhance your

design.

TTTTeeeexxxxtttt::::

- Use a number of unique text effects to help put the

finishing touches on your label design.

- Choose from circular, spoke, spiral, and drop shadow

text effects to enhance your label design.

- A number of different fonts & colors are offered as well.

PPPPllllaaaayyyylllliiiissssttttssss::::

- Add your playlists or data file lists into your label design

using the playlist manager.

- Import playlists from iTunes®, MusicMatch Jukebox®,

Windows Media Player® and more.

- Edit playlists as needed.

6) When you are satisfied with your printer calibration, click OOOOKKKK - this will save your settings and you

are now able to print perfectly positioned labels every time.

NNNNOOOOTTTTEEEE:::: Printers may vary in how they handle different paper types. Even if you calibrate your printer, the

paper may feed through the printer inconsistently causing misalignment. To reduce the effect of

errors caused by printer inconsistencies, place images and text 3-5 mm away from the edge of the

inner and outer edge of the label.

Using the Design Bar (on the left of the design screen)

AAAAccccttttiiiioooonnnnssss::::

- Start a New Design or open an existing project.

- Click the Add button to add copies of your label to your

print sheet.

- Use the << and >> buttons to scroll the label copies

- Click Save Design to save your design.
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Using the Variation Bar (on the bottom of the design sreen)

#1) Choose a BBBBaaaacccckkkkggggrrrroooouuuunnnndddd -Offers a number of backgrounds in the software's library.

#2) Choose a LLLLaaaayyyyoooouuuutttt SSSSttttyyyylllleeee - offers different title positioning, font type, and text effects.

#3) Choose a FFFFoooonnnntttt SSSSttttyyyylllleeee - offers a number of different font combinations.

NNNNOOOOTTTTEEEE:::: Layout Styles and Font Styles will differ depending on the label template being used.

#1 #2 #3

Using The Playlist Manager

UUUUsssseeee tttthhhheeee bbbbeeeelllloooowwww bbbbuuuuttttttttoooonnnnssss ttttoooo mmmmaaaannnnaaaaggggeeee yyyyoooouuuurrrr ppppllllaaaayyyylllliiiissssttttssss::::

IIIImmmmppppoooorrrrtttt:::: To import playlists from a database, a CD, or a MP3 CD.

AAAAdddddddd:::: To add songs to your existing playlists. This is great for creating your own playlists.

NNNNeeeewwww:::: To start a new playlist from scratch.

EEEEddddiiiitttt: To edit the selected playlist.

DDDDeeeelllleeeetttteeee: To delete the selected playlist.

AAAAppppppppllllyyyy:::: To apply the selected playlist to the design.

CCCCaaaannnncccceeeellll:::: To quit the Playlist Manager.

The Playlist Manager allows you to edit and manage

your playlists in your database. You can use existing

playlists or create a new playlist for your label.

Design Creation Tips and Tools

OOOObbbbjjjjeeeecccctttt MMMMooooddddeeee::::

Allows you to create, modify, delete, and position different elements of your design including:

• Graphic Objects

• Pictures

• Clip art

• Text Frames

• Tables
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TTTTeeeexxxxtttt MMMMooooddddeeee::::

Allows you to enter, edit, delete and format text in Text Frames.

TTTTIIIIPPPP:::: When you are in Object Mode, double-clicking on a text frame automatically switches you to Text Mode

and puts the text cursor in the frame.

TTTToooo CCCCRRRREEEEAAAATTTTEEEE SSSSppppiiiirrrraaaallll,,,, SSSSppppooookkkkeeee,,,, oooorrrr CCCCiiiirrrrccccuuuullllaaaarrrr TTTTeeeexxxxtttt::::

1) Click AAAAdddddddd CCCCiiiirrrrccccuuuullllaaaarrrr TTTTeeeexxxxtttt under the Text section on the Design Bar.

2) Under the Set Text tab, Select the CCCCiiiirrrrcccclllleeee TTTTyyyyppppeeee desired.

3) Select in the drop down menu – Spiral, Spoke, or Circle text.

4) Enter desired text in the text box and select OOOOKKKK....

TTTTIIIIPPPP:::: Reduce the font size, first, before reducing the size of the text frame when adjusting circular, spiral,

or spoke text.

TTTToooo AAAADDDDDDDD CCCCuuuussssttttoooommmm bbbboooorrrrddddeeeerrrrssss ttttoooo yyyyoooouuuurrrr ddddeeeessssiiiiggggnnnn::::

Use the variation bar at the bottom of the design screen, scroll the layout styles (middle button), until you

reach “Bleeding edge”.

OR

1) Click AAAAdddddddd CCCCiiiirrrrccccuuuullllaaaarrrr TTTTeeeexxxxtttt.

2) Under the Set text tab, select “Circular” under Circle Type.

3) Add desired border text in the text box.

4) Click on the Effects tab to adjust font color, background color, etc…

TTTToooo SSSSAAAAVVVVEEEE aaaa LLLLaaaabbbbeeeellll DDDDeeeessssiiiiggggnnnn::::

1) Click SSSSaaaavvvveeee DDDDeeeessssiiiiggggnnnn on the “Action” bar or SSSSaaaavvvveeee in the File menu.

2) Adialogue box will appear – pick a filename and choose file type as DDDDeeeessssiiiiggggnnnn.

3) Click Save once you decided on the filename and folder.

TTTToooo OOOOPPPPEEEENNNN aaaa LLLLaaaabbbbeeeellll DDDDeeeessssiiiiggggnnnn::::

1) Click OOOOppppeeeennnn DDDDeeeessssiiiiggggnnnn on the action bar or OOOOppppeeeennnn in the File menu.

2) Find the folder and file name under which you saved the design.

3) Click OOOOppppeeeennnn in the dialogue box to open the file.

TTTToooo AAAADDDDDDDD aaaa BBBBllllaaaannnnkkkk DDDDeeeessssiiiiggggnnnn::::

1) Under the AAAAccccttttiiiioooonnnnssss bar, when on your last label design, Click >> .

2) The “Create a New Design?” screen will appear:

Click YYYYeeeessss to add a blank design to the project.

Click NNNNoooo to go back to the original design.

TTTToooo AAAADDDDDDDD aaaa DDDDuuuupppplllliiiiccccaaaatttteeee ooooffff CCCCuuuurrrrrrrreeeennnntttt DDDDeeeessssiiiiggggnnnn::::

Click AAAAdddddddd under the AAAAccccttttiiiioooonnnnssss bar.

Use the << and >> buttons to scroll through designs.
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Memorex exPressit™ Label Design Studio HELP Section:

- Feature-related tutorials take you step-by-step through many of Memorex's exPressit Label Design Studio

capabilities, including creating a new label, working in the design area, creating text effects, working with

playlists and printing.

NNNNOOOOTTTTEEEE:::: Label designs saved using Memorex exPressit S.E. 2.2 or older are not supported for use in

Memorex exPressit Label Design Studio.

HHHHeeeellllpppp

The Help section of the software will provide you with tips of the day, general help tutorials, and a help link among

other tools.

The Help menu provides access to:

• Memorex exPressit Tutorials

• Pop-up Help

• Tips of the Day

• Internet support, including News and Special Offers, Program Updates and Support Groups.

TTTTeeeecccchhhhnnnniiiiccccaaaallll AAAAssssssssiiiissssttttaaaannnncccceeee

Should you require assistance or have questions regarding your Memorex exPressit Label Design Studio or

LabelMaker Product, feel free to search for answers on our website at www.memorex.com or if you are residing

in the USA or Canada, call us at 877-is it Live (877-474-8548).

Hours of operation are 9am-6pm pst., Mon.-Fri.


